1

Psy 103 General Psychology – Spring 2017 – Article Review
You will be asked to complete four short assignments over the course of the semester. These
assignments are meant to give you experience in tasks that you will have to complete for other courses
in the future and to give you an opportunity to use psychology to help you be successful. The second
short assignment is the article review and will be due in Week 6.
In the first short assignment (library database exercise) you gained experience locating scholarly articles.
The second short assignment gives you the opportunity to practice reading, summarizing, and critiquing
scholarly materials. An article review is a paper in which you review a scholarly article.
For this assignment, I am providing you with an article. I have intentionally selected one that is atypical
for a scholarly article because it was published in the Journal of Indigenous Research, which is a
publication that is peer-reviewed but the authors are required to aim the writing at the general public,
not just at other psychologists. This will hopefully make the reading more accessible to you. In addition, I
intentionally selected a text written by a Native American psychologist (the author is Cherokee and
Choctaw).

Your Task:
Read the provided article:
You are required to read the provided article in-detail (don’t just skim it). Mark sections that you find
particularly interesting/important, and write down comments in the margins such as if something
surprised you or if you have questions about something, but also if you strongly agree or disagree with
something.

Write the article review:
Your article review should consist of two parts. You are not required to use headings to mark the two
parts but you have to keep the content of the two separate.
-

1st half (approximately 200 words): Summary of article: In this section, you summarize the
content of the article in your own words. The summary should consist of a description of what
you identify as the most important points that the author makes.
It is recommended that you don’t have the article in front of you while you write this summary
so you don’t copy word-by-word from it. Important: Do NOT include your own views in this
section (e.g. don’t write what you like/dislike about a certain part of the article).

-

2nd half (approximately 200 words): Your views: In this section, you are asked to describe your
views about the article: What do you think about the author’s arguments? Do you agree or

2
disagree with him? Why do you agree/disagree? What do you think about how the article is
written? Did the author neglect to include something that you think should have been included?
What do you think is the purpose of the article?

Format your paper in APA format:
This paper needs to be in APA format because I want you to practice using this format as you will be
expected to know how to use it in future courses. Since I see this as a practice, APA format will make up
some of the points that you can earn for the assignment but you can still earn a good grade even if the
format is not yet perfect.
So what does APA format entail? For this specific assignment, the following elements are required: title
page in APA format, running head, double-spaced paper, in-text citation of article, detailed citation of
article in a references list.

APA title page and running head (a sample title page is attached): In APA format, the title page is not
fancy but rather dry. Centered in the middle of the title page, you first list the title of your paper. This
can be the title of the article or you can come up with a different title. Below the title, you list your first
and last name and, on new lines, the course code and title (Psy 103 General Psychology), and the date
when you complete the paper.
In addition, there needs to be a so-called running head in the header section of all your papers. On the
title page, the header on the left side should read “Running head: SHORT TITLE OF YOUR PAPER” (yes,
the words “Running head” need to be there, though not all capitalized). On the following pages, the
words “Running head” are not included anymore, so it’s just “SHORT TITLE OF YOUR PAPER.” It takes
some time to set up the header correctly but you can just follow the step-by-step instructions provided
in the separate handout.
Main part of paper: Centered at the top of the second page, you need to repeat the full title of your
paper (the same as what you write in the middle of the title page). Right underneath the title, you write
the two parts of your article review.
Your whole paper should be double-spaced: Select your whole paper and then click on the “Line and
Paragraph Spacing” symbol on the “Home” tab and select “2.0”:

Citation of article: Whenever you write a paper, you need to include the source of your information
right within the paper (=in-text citation) and then in more detail at the end of the paper (=references).
Think of citations like this: When you are telling your friends a story that your grandpa told you, you will
not just tell the story without reference to your grandpa: You will most likely start out with saying “My
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grandpa told me…” That’s the same thing as in-text citation. In-text citation is needed whether you copy
what someone else wrote word-by-word or if you describe the information from in your own words. In
case of this specific assignment, you only need to use one source, the article that I give you, so this is the
only source you will cite. To avoid disrupting the text too much, in-text citations are not very detailed.
They only include the author(s) last name(s) and the year in which that specific source was published
(and the page number if the quotation is word-by-word). This information is not sufficient for someone
else to find your source to read more about it. It is therefore necessary to include more detailed
information at the end of the paper. This is done in a list titled “References” on the very last page. The
following is a description of how exactly you need to format the in-text citations and the references (the
latter is a repetition of what you did for the library databases exercise):

Format citations within the text
Direct quotations:
If you cite someone else’s work word-by-word, you need to put that quotation in quotation marks (“),
and after the quotation, you include information on the author, the publication year as well as the page
number.
Example 1: “Talk about how to demand respect and deference occurs in many places, most often within
homes and schools but also around pickup basketball courts” (Jimerson & Oware, 2006, p. 27).
Alternatively, the name(s) of the author(s) can also be included in the text outside the quotation:
Example 2: Jimerson and Oware (2006) concluded “talk about how to demand respect and deference
occurs in many places, most often within homes and school but also around pickup basketball courts”
(p. 27).

Paraphrasing
You should keep direct quotations to a minimum in this particular paper. Instead, you paraphrase the
information from other sources: you describe it in your own words. This means that you shouldn’t just
switch a few words around. One trick is to put the original away and write down what you remember.
The example below is not ideal because it focuses on the same information from one sentence. It’s
better to look at whole paragraphs, pages, etc. Even when you paraphrase, you still need to cite the
source of your information, but you don’t put any text in quotation marks.
Example 3: The question of how to make others show respect is frequently discussed at places like the
home, school and basketball courts (Jimerson & Oware, 2006).
Or

4
Example 4: As Jimerson and Oware (2006) describe, the question of how to make others show respect is
frequently discussed at places like the home, school and basketball court.
For this specific assignment, I recommend that you start out your summary with saying that you are now
summarizing article xyz by author x (year). This way it’s clear that the following is all from the same
source. If you don’t do it this way, you will have to include the source in every paragraph of the
summary.

Format references
As mentioned above, you need to include more detailed information on your source in References on
the last page of the paper. You will need to include the following information (in this order):
a)
b)
c)
d)

Author(s) last name(s) and initials first/middle names
Publication year
Title of the article (that’s the heading that is on the first page of your article in the largest font)
Title of the journal in which it was published. This will be something like Canadian Journal of
Experimental Psychology, etc. This information can typically be found in the footer or header of
the page(s)
e) Volume in which this article was published: This is based on the publication year: the first year in
which a journal is published is Volume 1.
f) Issue in which this article was published: Many journals are published more than once a year so
whereas the volume number is the same whether an article is published in January or August of
a year, the issue number will tell us when in the year it was published (e.g. 3rd issue in volume
43)
g) Page numbers: on which page of the journal does the article start, where does it end?
This is what it needs to look like:
Author1 last name, initials first/middle names, Author2 last name, initials first/middle names, & Author3
last name, initials first/middle names. (publication year). Title of the article. Title of the Journal, Volume
Number(Issue Number), starting page-end page.
Here is an example (please pay close attention to punctuation, use of italics and punctuation):
Ruchkin, D. S., Grafman, J., Cameron, K., & Berndt, R. S. (2003). Working memory retention systems: A
state of activated long-term memory. Behavioral and Brain Sciences, 26(6), 709-728.
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Article Review – Grading Rubric
Element

Exemplary

Pts.

Acceptable

Pts.

Unacceptable

Pts.

Title page

Running head, title, student name,
course title, date

4-5

Evidence of 3 or 4

2-3

Evidence of 2 or less

0-1

Grammar,
syntax, and
spelling

Paper flows well and is clear and easy
to read due to use of proper syntax,
grammar, spelling, and punctuation.
The writing is almost error free.

4-5

The paper is unclear or hard to read
because syntax, grammar, spelling, or
punctuation is poor.

2-3

0-1

Content I:
Summary

Paper includes a detailed summary of
the article

2125

Summary of article is too superficial

12-20

Content II:
Student’s views

Student demonstrates critical thinking
in detailed description of views

2125

12-20

Overall clarity
and form

Student uses essay form and the
assigned paper format (APA).
Sentences and paragraphs follow
each other in a logical order. The
material is presented so that the
reader does not have to stop and
back up to comprehend it.
The tone is consistently professional
and appropriate for an academic
essay/paper.

4-5

Student demonstrates some critical
thinking but the description of views is
too superficial
Student fails to use more than one of
the elements of essay form and the
assigned paper format OR the paper is
difficult to follow in some places.

The writer’s intentions are
unclear because paper’s
syntax, grammar, spelling
and/or punctuation are
poor.
The paper does not
include a summary of the
article
Student demonstrates
only limited critical
thinking
The paper is generally
hard to follow due to
problems with format,
essay form, and/or the
way material is presented.

4-5

The tone is generally professional for
the most part.

Paper is the assigned length when
margins, spacing, and font size are
considered. Only information relevant
to the assigned topic is included.
Assigned length: at least 400words
not counting title/page nor references
Information from sources is reported
accurately.
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Paper is a page or two shorter than the
assigned length when font, margins,
and number of pages are taken into
account.

Tone

Length

Accuracy

9-10

Some information is reported
inaccurately or out of context.

2-3

2-3

Grade reduced by
percentage of the
assigned length
not included.
6-8

The tone is not
consistently professional
or appropriate for and
academic essay/paper.
Paper is substantially
shorter than the assigned
length when font,
margins, and number of
pages are taken into
account.
Information is included
without regard for
accuracy.

0-11
0-11
0-1

0-1

Grade
reduced by
percentage of
assigned
length not
included.
0-5
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References

Presentation

All information is clearly linked to its
source. References are provided in
the correct format.
Assigned format: APA
Paper is turned in on the assigned
date. Format is correct.

Total: 100 points
4% of final grade AND extra credit

8-10

-

Sources of information are included,
but other information sources are not
mentioned. References are not in the
proper form.
Paper is turned in late.

4-7

Up to 1week late:
10% reduction
More than 1week
late: 30%
reduction

The sources of the
information in the paper
are not identified.
Paper is turned in after
the last class period.

Paper is
returned to
the student.
Paper is not
accepted.

Running head: TREATMENT OF SUBSTANCE ABUSE

Native American Approaches to Treating Substance Abuse
Your First Name and Last Name
Psy 103 General Psychology
September 9, 2014
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APA Formatting in Word 2013
The American Psychological Association (APA) style for formatting an essay is not a
setting in Microsoft Word 2013. However, by following these steps, you can set up
your document according to APA style.
1. Open Microsoft Word 2013 to a blank document.

2. Type the title of your essay, your name, and Zane State College, all on separate lines.

APA Formatting in Word 2013
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3. APA format requires certain font formatting. Select the text you just typed, and
change the font to Times New Roman, size 12.

Type “Times
New Roman” in
the font box

Select “12”
Click and drag to select text, or hold
down the Ctrl key and press the A key

4. APA also requires other formatting. With the text still selected, change the
paragraph spacing to zero (0) and the line spacing to double (2.0).

Set “After” to 0

Change to
“Double”

Click to open
Paragraph box
Click “OK”

5. The rest of the document should be formatted the same way. With the text still
selected, right-click the Normal style and choose “Update Normal to Match
Selection.” All new text will now be formatted properly.

Right-click and choose “Update Normal to
Match Selection”

APA Formatting in Word 2013
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6. To start setting up the text in the document, center the text you had typed.

Click to center text

7. The title page information should be farther down the page. Position the insertion
point (blinking bar) before the beginning of the title. Press Enter a few times to
position the text in the top third of the page. It should not be any lower than
halfway down the page.

APA Formatting in Word 2013
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8. To start the second page, position the insertion point (blinking bar) at the end of the
word “College.” Open the Insert tab and click the Page Break button. In the first line
of page 2, type the title of your essay and press Enter.

Open Insert tab
Add page break

9. Set the second line to left-align, press Tab (on the keyboard) to indent the first
paragraph, and begin typing the first sentence of your essay.

Click to left-align text

10. You are now ready to set up the header. Scroll back up to the top of the document,
and double-click anywhere in the blank area at the top of the page. This will open
the header. The first thing to do is check the “Different First Page” box. Do this
before you type anything in the header.

Check “Different First Page”

APA Formatting in Word 2013
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11. To insert a page number, click on the Page Number button, choose “Top of Page,”
and then choose “Plain Number 1.” (If you simply type a number, that number will be
on each page.)

12. Now, type the words “Running head:” and the title of your essay. Be sure to put the
title of the essay in ALL CAPS, and do not capitalize “head.”

13. The page number should be on the right margin. To “bump” it over, press Tab twice.

APA Formatting in Word 2013
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14. Now, scroll down until you see the header space for page 2. Insert the page number
using the exact same process as in steps 11, 12, and 13 above. The only difference is
that this page will not require the words “Running head.” Just type the title of your
essay in ALL CAPS.

15. You have now finished setting up your document in APA format. Double-click
anywhere in the main body of your document to close the header view (or click the
Close Header and Footer button). Go to page 2 and continue typing your essay.

APA Formatting in Word 2013
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